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How to use this Addendum 

This document is an addendum to the GageScope® User’s Guide (Eighth Edition) and is 
intended to provide supplementary information specific to installing and using GageScope®.  
It also provides a list of errata that documents changes to certain features and functionalities.  
When applicable, section headings include a page number that refers to the page to which the 
changes belong in the manual. 

At Gage we strive to always supply the best possible software.  Users should keep in mind 
that software functionality is continually evolving.  Considering the size of the User’s Guide, 
it is possible that some images (screen grabs) do not exactly match the software as you will 
experience it.  Such situations, when they occur, will not materially affect your use of the 
software or the instructions on how to use certain features. 

Please read the ReadMe.txt file on the accompanying CD for the most up-to-date information 
on Enhancements, Bug Fixes and Known Bugs. 
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Changes to Multi-Instrument Support 

In order to improve the inter-operability of its various products, Gage has changed the default 
support for multiple instruments in GageScope®.  This change will be reflected in future 
editions of the User’s Guide. 

By default, GageScope® now only operates analog CompuScope acquisition cards. 

Because the .SIG file format is hardware independent, GageScope® can still load .SIG signal 
files created for analog output CompuGen cards as well as from digital output CompuGen and 
digital input CompuScope cards. 

It is also still possible to use GageScope® to control an analog CompuGen card so as to 
tightly integrate in a single application both CompuGen and CompuScope products.  To do 
this, simply add �-generator� to the GageScope® command line within the �Target� field 
which appears in the Properties of the GageScope® desktop shortcut.  This command line 
option may be used with any other command line option. 

Everything in the manual concerning the CompuGen products remains valid, although you 
may prefer to use the CGWin application instead of GageScope® to set-up and control the 
AFG and AWG functionalities. 
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Changes to Probe Support 

For regulatory and safety reasons, Gage does not recommend the use of probes with its 
CompuScope cards.  This change will be reflected in the future editions of the User’s Guide. 

 

By default, GageScope® no longer allows you to specify the probe settings.  Therefore, please 
note that the probe box on the CS Input Tab of the Channel Control has been removed. 

 

This change affects the User’s Guide in the following manners: 

• Page C-137 is no longer valid. 

• The images on pages 
B-46, B-47, B-62, B-63, B-65, B-67, B-70, B-71, B-72, B-118, B-132, B-133, B-
134, B-136, B-137, B-138, B-139, B-142, B-143, B-144, B-145, B-148, B-150, B-
151, B-153, B-154, B-156, C-137, C-138, C-139, C-140, C-141 
are no longer identical to how they should appear on your screen.  Please note that 
this in no way affects the functionality described on those pages; only the images are 
inaccurate. 
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Introduction (page viii) 

Please note that a Lite Edition of GageScope® now exists.  A table of features will follow. 

 

GageScope® is a powerful software package which, finally, bridges the gap between 
oscilloscopes and computers, helping scientists and engineers get the most out of their 
measurements. 

All this performance is available without writing a single line of code or drawing any 
diagrams.  GageScope® starts being productive right out of the box. 

GageScope® takes full advantage of the Windows operating system, making the user interface 
for CompuScope and CompuGen cards very easy to learn and use.  

On-screen controls and toolbars give you complete control of all capture and display features, 
allowing you to change settings while data capture is in progress.  As many as 60 channels 
can be viewed together on the screen, and signals can be saved to disk for future use. 

Optional software advanced analysis tools allow the power of GageScope® to be further 
enhanced by allowing deep FFTs, unattended transient capture, averaging, waveform 
parameter calculations and correlation.  Many more analysis tools will become available in 
the future, making GageScope® even more powerful. 
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GageScope® is now available in the Lite, Standard and Professional Editions. 

• GageScope® Lite Edition 

Free Edition of GageScope® that provides basic functionality.  See table of features 
on the next page. 

• GageScope®  Standard Edition 

GageScope® Edition for Intermediate Users 

All advanced analysis tools, with the exception of the Extended Math tool, are 
included in the Standard Edition but with limited functionality.  The limitations are 
listed as follows: 

• AutoSave can only save a maximum of 4 files  

• While Averaging, running average is not available and the maximum averaging 
depth is 8192  

• Waveform Parameters tool supports only the following parameters: 

• Period  
• Frequency  
• Mean 
• RMS 

• The maximum length of FFT is 4096 points 

• Extended Math tool is not available 

• GageScope® Professional Edition 

GageScope® Edition for Expert Users 

This edition contains the following advanced analysis tools: 

• AutoSave 

• Averaging 

• Waveform Parameters 

• FFT 

• Extended Math 
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 FEATURES/FUNCTIONS  
     
     
USER INTERFACE & CONTROL 
 Search for waveform point or segment √ √ √ 

 Graphical arbitrary waveform display window √ √ √ 

 InfoView Palette √ √ √ 

 Comprehensive Toolbars √ √ √ 

 Status Bar √ √ √ 

 Horizontal and Vertical Scroll Bars √ √ √ 

 Channel, System and Display Control Window √ √ √ 

     
 
ACQUISITION 
 Export waveform file formats  ASCII SIG, ASCII, EQU SIG, ASCII, EQU 

 Import equation files and data values from other Microsoft Applications √ √ √ 

 Import DSO signal files from disk/PC √ √ √ 

 Import AWG/AFG files from disk/PC √ √ √ 

 Internal or external Trigger Control √ √ √ 

 Scope Mode  √ √ 

 Min Max Decimation   √ √ 

 Skip Sample Decimation   √ √ 
 Sample Rate Up to 5GS/sec Up to 5GS/sec Up to 5GS/Sec 

 External Clock support √ √ √ 

 2 GB Acquisition memory √ √ √ 
Advanced Triggering control √ √ √ 

 Left and Right Trigger Alignment  √ √ 

 Multiple independent triggers  √ √ 

 2 trigger modes (single and continuous) √ √ √ 
 Averaging/Co-Adding  8192 maximum 

averaging depth 
√ 

 Decoupled Timebase and Sample Rate √ √ √ 

 Simultaneous input channel sampling √ √ √ 

 8, 12,14,16, and 32 bit vertical resolution √ √ √ 

 SuperRes mode  √ √ 
 Multiple Channel Input 32 32 32 
 Multiple Record Mode  √ √ 
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VISUALIZATION - DYNAMIC DISPLAY 
 Mixed signal display (marker display/edit) √ √ √ 
 Real-time Data Display √ √ √ 
 Deep Memory Zoom   √ √ 
 Numeric Display √ √ √ 
 Compression utility (change clock rate) or Zoom √ √ √ 
 Scrolling features √ √ √ 
 Cursors with readings of amplitude and time  √ √ 
 Display waveforms in time and points √ √ √ 
 Engineering Units  √ √ 
 Up to 30Hz display refresh rate √ √ √ 
 Overlay Channels with independent vertical scale √ √ √ 
 Simultaneous time and frequency domain display √ √ √ 
 Multiple Displays of same signal  √ √ 
 Multiple channel capability Up to 60 Up to 60 Up to 60 
 Multiple Channel Display Windows  √ √ √ 
 Timed & Infinite Persistence Display Mode √ √ √ 
     

DOCUMENT 

 Print Hardcopy   √ √ 

 Full print options and print previewing menu  √ √ 

     

     

ANALYSIS 
 Dual cursor with tracking mode  √ √ 
 Math Channel  √ √ 
 Waveform Analysis Parameters  Support for Period, 

Frequency, Mean, 
and RMS only 

29 

 FFT Analysis  4096 maximum 
record length 

√ 

 Extended Math channel - function   √ 
 Sub-Channel  √ √ 
     

     

DATA MANAGEMENT 
 Save and Restore of Setup  √ √ 
 Save waveform files to different formats ASCII BIN, SIG, ASCII, 

FMT, EQU, PRN 
BIN, SIG, ASCII, 
FMT, EQU, PRN 

 Split File Save  √ √ 

 Store AWG signal files to PC  √ √ 
 Output frequency filter √ √ √ 
 Create and Save Math channels  √ √ 
 Signal File comment field √ √ √ 
 Share files via WWW, email, LAN, WAN √ √ √ 
 AutoSave - Playback  √ √ 
 AutoSave - Unattended transient Capture  Maximum 4 Files √ 
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SCALABILITY 
 From 1 to 32 channel acquisition capability √ √ √ 

 Windows 95/98/NT4.0/Win2000/WinXP/WinME compatible √ √ √ 

 
    

HARDWARE SUPPORT 
 Support multiple CompuGen boards in same system √ √ √ 

 Support for CompuScope Cards √ √ √ 

 Automatic Hardware Detection and Configuration √ √ √ 

 Single and Multi-card support √ √ √ 

 

ARBITRARY WAVEFORM GENERATOR 
 Autoline function (autodraw)  √ √ 

 Stretch waveform by dragging points or segments  √ √ 

 Multiple paste segment every x points  √ √ 

 Graphical Waveform Editor   √ 

 Generate user defined waveforms   Up to 2,048 points Up to 2,048 points 

 Multi-channel waveform editor - up to 10 simultaneous channels  √ √ 

 Edit entire waveform  √ √ 

 Create waveform masks, envelopes  √ √ 

 Create jitter on waveform signal √ √ √ 

 Variable clock rate √ √ √ 

 Create waveform by selecting pre-defined waveform style √ √ √ 

 Frequency range adjustment control √ √ √ 

 Offset control √ √ √ 

 Amplitude control √ √ √ 

 Adjustable duty cycle  √ √ √ 

 Define waveform offset √ √ √ 

 Define delay times √ √ √ 

 Supply list of 30 standard waveforms/predefined signals (Sine, square, 
triangle, ramp) and user-defined waveforms 

√ √ √ 

 Signal Calculator performs waveform math and user-defined functions √ √ √ 

 Create and edit waveform by equation entry √ √ √ 

 26 Math Transfer functions  8 basic functions √ 

 6 Math Operations √ √ √ 
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Specifications (page xiii) 

This section provides you with an updated list of System Requirements and Currently 
Supported Instruments.  The list of Currently Supported Driver Versions has been added to 
this section, and will be included in future editions of the GageScope® User’s Guide. 

System Requirements 

• PC with a Pentium 200 MHz processor; 266 MHz Pentium II or higher strongly 
recommended 

• Microsoft Windows 95, Windows 98, Windows NT 4.0 or Windows 2000, Windows XP 
or Windows ME operating system 

• 32 MB RAM with Windows 95/98, 48 MB RAM with Windows NT/Windows 
2000/Windows XP/Windows ME; 128 MB RAM or more recommended on all systems 

• Hard disk free space: 20 MB to install the GageScope® application; 40 MB for full install 
(includes Online Help facility and PDF version of User Manual).  128 MB minimum free 
space necessary for operation of the GageScope® program 

• Virtual memory under Windows NT, 2000, XP, and ME: it is recommended that you 
increase the Swap File Size by 128 MB to operate GageScope® 

• CD-ROM drive  

• 15-inch monitor 800 x 600 (Super VGA); 17-inch 1024 x 768 Ultra VGA recommended.   
Note that your system must be set to 256 color display in order for the FFT capability to 
display results properly. 

• PC keyboard and 2-button mouse (3rd button, if present, is not used) 

• Internet Explorer 4.1 or higher; version 5.0 required for full functionality 

• The drivers for the PC-based cards must be installed. The PC-based cards are the 
CompuScope and CompuGen card(s).  You must run the Instrument Manager utility to 
configure the PC-based cards. 
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Supported Instruments 

CompuScope Cards 

CS85GC, CS85G, CS82GC, CS82G, CS8500, CS14100C, CS14100, CS1450, 
CS12100, CS1250, CS1610C, CS1610, CS1602, CS3200 

 

CompuGen Cards 

CG1100, CG3250 

Supported Driver Versions  

CompuScope drivers for Windows 95, Windows 98, Windows NT, Windows 2000, 
Windows ME and Windows XP. 

3.60.02, 3.60.00, 3.50.02, 3.50.00, 3.48.00, 3.46.02, 3.46.00, 3.44.00, 3.42.04, 
3.42.02, 3.42.00, 3.40.00, 3.32.00, 3.30.06, 3.30.04, 3.30.02, 3.30.00, 3.24.02, 
3.24.00, 3.22.07, 3.22.06, 3.22.05, 3.22.03, 3.22.02, 3.22.00, 3.20.13, 3.20.12, 
3.20.09, 3.20.08, 3.20.07, 3.20.06, 3.20.05. 

CompuGen drivers for Windows 95, Windows 98, Windows NT, Windows 2000, 
Windows ME and Windows XP. 

1.28.02, 1.28.00 
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Installing GageScope® (page A-3)  

The installation procedures outlined in the GageScope® User’s Guide (Eighth Edition) 
pages A-3 to A-8 (Steps 1 through 13) have been changed to the following steps.  Please 
note that the changes affect both the procedure and the graphics displayed. 

Step-by-step Installation 

1 Insert the GageScope® CD-ROM into your CD-ROM drive. 

The installation program should start automatically after a few seconds.   

2 In case the installation program does not start automatically, follow these steps to start 
the setup process: 

Click Start from your desktop and select Run.  You will see the Run dialog box as 
follows: 
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3 Type CDROM drive letter:\GageScope\Disk1\Setup.exe in the Open text box.  
The CDROM drive letter depends on the settings in your PC.  

 

Click OK. 

4 If you are running a Windows 95 system that does not have the appropriate version of 
DCOM95 installed, you will be asked if you want to install DCOM95.  You must select 
the installation of DCOM95. 

After DCOM95 has been installed, you will then have to reboot your PC and run the 
GageScope® installation program again. 

If you are installing GageScope® under Windows 98, Windows NT, Windows 2000 or 
Windows XP, the DCOM95 will not be installed as these operating systems come with 
all DCOM components required by GageScope®. 

5 If your system does not have Internet Explorer 5.0 or equivalent installed, you will be 
asked to install Internet Explorer 5.0 from Microsoft�s web site. 

After Internet Explorer 5.0 has been installed, you will then have to reboot your PC and 
run the GageScope® installation program again. 
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6 The installation program will begin the setup procedure.  You should then see the 
following Welcome screen. 

Click Next. 
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7 In the Customer Information screen, enter your User and Company name. 

 

Now click Next. 
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8 The following selection menu will then appear.   

GageScope® 3.5 is available in 3 different editions.  A detailed description of each 
Edition is listed within this Addendum, and is also available on our website at 
www.gagescope.com. 

Please select the Edition that is most appropriate to suit your needs.  
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9 If you select either the Lite or Standard Editions, you will be given the choice to evaluate 
GageScope® Professional Edition for a limited time.   

In this example, it is assumed that you have chosen to install the Lite Edition.  However, 
the steps are similar when installing the Standard Edition. 

 

 

If you choose to install the Lite Edition then proceed with the following steps. 

If you choose to try the GageScope® Professional Edition for 21 days or 50 sessions, then 
skip to step 12. 
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10 In order to proceed with the installation of GageScope® Lite edition, you will need a Lite 
Edition Software key. 

You must register on-line at www.gagescope.com/registration to obtain the GageScope® 

Lite Edition software key.  Once you have registered, the Lite Edition Software Key will 
be e-mailed directly to you.    

A GageScope® Lite Edition software key cannot be obtained by contacting Gage or its 
representatives by telephone, fax or e-mail. 

 

Click on the NEXT button or simply click on the Install GageScope® Lite Edition � 
software key required dialog box. 

If you are installing GageScope® Standard or Professional Edition, you will be asked to 
enter your software key which has been provided to you with your GageScope® order.  
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11 You will then be prompted to enter your GageScope® Software key. 

 

Click NEXT. 
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12 Select the components that you wish to install and their destination location.  

 
 

Click NEXT. 
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13 Then select a Program Folder.   

It is recommended that you accept the Gage program folder and click Next; otherwise, 
type in another name and click Next. 

 

 

14 The installation process will commence.  You will see the installation progress indicators 
during this installation process.  
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15 Once the installation process is finished, the Setup Complete screen will appear. 

Click Finish to complete the Setup process. Installation is now complete. 

  

IMPORTANT:   

• If you have not already done so, you must now proceed to Install the Windows 
device drivers for your CompuScope and CompuGen card(s). 

• After installing the drivers, use the Instrument Manager utility to configure these 
PC-based cards. 

 

 



Addendum to GageScope® User�s Guide 26
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Registering GageScope® 

Please note that this is a new section that will be included in future editions of the 
GageScope® User’s Guide, in the Getting Started chapter.  

Trial of GageScope® Professional Edition 

If you are installing GageScope® Lite Edition or GageScope® Standard Edition, upon 
installation of GageScope®, you will be asked if you would like to run a free 21 day, 50 
session Trial which will allow you access to all features of the Professional Edition for a 
limited time.  You do not need to enter any software key to run the Trial. 
 
Once the trial period has expired, GageScope® will no longer run unless you: 
 

1. Purchase the Standard or Professional Edition Software Key from Gage.  Please refer 
to the �Upgrading GageScope� section of this Addenda 

 
Or 
 

2. Register to obtain a FREE �GageScope® Lite Edition Software Key� to convert the 
software to a Free GageScope® Lite Edition.  The GageScope® Lite Edition provides 
basic functionality.  The steps below illustrate how GageScope® will prompt you to 
register to obtain your GageScope® Lite Edition key. 
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Launching GageScope® Trial  

1 Upon launching the Trial of GageScope® Professional Edition, a menu will prompt you 
to either register the current version of the software or to purchase the Standard or 
Professional Edition upgrade. 

 

Select Continue to launch the Free 21 day, 50 session trial of GageScope® Professional 
Edition. 

If you have a software key and do not want to run the trial of GageScope® Professional 
Edition, select Enter Software Key.   
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GageScope Software Keys 

2 The GageScope® Software Key dialog box will appear and will prompt you to enter your 
software key.  If you have purchased a Standard or Professional Edition software key, 
you were provided a key with your order.  Enter your software key here.  See �Upgrading 
GageScope®� section in this addenda for more information.   

To obtain a free GageScope® Lite software key, you must register on-line at 
www.gagescope.com/registration.  Once you have registered, the Lite Edition software 
key will be e-mailed directly to you.    

A GageScope® Lite Edition software key cannot be obtained by contacting Gage or its 
representatives by telephone, fax or e-mail. 
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Upgrading GageScope®  

This section explains how to go about upgrading your software to either a Standard or a 
Professional Edition.  This is a new section that will also be included in future editions of  the 
GageScope® User’s Guide.  
 

 

The upgrade options are as follows: 

1. From the Lite Edition, you have the choice to upgrade to either the Standard or the 
Professional Edition. 

2. From the Standard Edition, you may upgrade to the Professional Edition. 
 
 
 
 
1 If you are using either the Lite or Standard Edition of GageScope®, you may upgrade 

your software at anytime by clicking on any of the features that are normally not available 
for that particular Edition.  For instance, click on the Extended Math button on the toolbar 
(third button from the left). 

The Unavailable feature dialog box will appear. 

 

Simply click on the Upgrade button. 
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2 The GageScope® Software Key dialog box will appear, prompting you to enter a 
GageScope® Standard or Professional software key. 

 

You will need to purchase a GageScope® Standard or Professional key in order to 
upgrade your current edition of GageScope®. 

For upgrade information, you may contact Gage at: 1-800-567-4243, or +1-514-633-7447 
if outside North America.  You may also visit www.gagescope.com for more information 
on the Standard and Professional editions of GageScope®. 

3 The following dialog box will then appear, confirming that the software key has been 
accepted. 

 
You will need to restart the application for the upgrade to take effect. 
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Launching GageScope® for the First Time (page A-15) 

Please note that the procedure section describing �No Instruments Detected� has been 
changed to include and reflect the use of the new Demo modes.  It also includes the 
description of the sample signal data files that are incorporated in the new Advanced Demo 
mode. 

 

Before you run the program, connect a signal (from a signal generator or other source) to the 
Channel A input of your CompuScope card. 

Launching GageScope® 

1 A Windows shortcut icon was placed on the desktop during installation. 
Double-click this icon to run GageScope®. 

You can also access GageScope® through the Start menu. Click on Start → 
Programs → Gage → GageScope → GageScope. 

2 If your CompuScope card is configured properly, GageScope® will start. 

 
In the above example, two signals are being acquired using a CompuScope 14100.  Your 
screen may differ.  If you are not feeding any signals into the input channel(s), you will 
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see a flat line. 

Demo Mode - No Instruments Detected? 

The dynamic demo mode of GageScope® allows you to evaluate GageScope® software 
even if you do not own any Gage hardware.  Input signals are simulated using signal files 
supplied with GageScope®. 

There are two different Demo modes, Basic and Advanced.  You can start the 
GageScope® demo by going to the Help menu in GageScope®.  This demo also starts if 
you do not have any Gage hardware and drivers installed in your computer. 

• If you do not have any instrument installed in your system, you will see the 
following message at launch: 

 

 

 

• Click on the Yes button. 

• As you are not connected to a live instrument, the software will launch the Demo 
Mode, which simulates several signals allowing full analytical features of 
GageScope® to be tried. 
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Both Demo modes demonstrate functionality that is available with CompuScope products 
only.  Furthermore, the implementation simulates one CompuScope card (similar to 
CS14100-1M) with two or four channels and displays a predetermined signal on each of these 
channels. 

The signals look and behave just like real inputs, allowing you to perform operations and 
extract values from the signals.  This dynamic demonstration and evaluation mode is one of 
many unique features of GageScope®. 

 

 

 

Click OK.
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The Basic Demo Mode emulates the following signals: 

1. Sine Wave of 870 mV amplitude, 40 kHz frequency with 8 LSB RMS noise 
2. Triangle wave of 900 mV amplitude 40 kHz frequency with 17 LSB RMS  

 

 

 

Should you choose not to use these files, you can, however, also load and save disk-based 
GageScope® files (extension .SIG).  To load a file, click on File → Load Channel.  Sample 
.SIG files are located in the Signal Files folder inside the C:\Gage\GageScope folder. 

This ability to load .SIG files means that the Demo Mode of GageScope® can be used as a 
powerful viewing tool to share acquired data with your colleagues. 
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The Advanced Demo Mode (available from the Help menu) emulates the following signals: 

1. Amplitude modulated sine wave of 2.13 MHz carrier frequency, 800 mV carrier 
amplitude, 44.73 MHz modulation frequency, 110 mV modulation amplitude and 
17 LSB RMS noise. 
 

2. Pulse with ring down. Frequency of 1.16 MHz, duty cycle 50% +/- 20% and 
amplitude of 1.7V.  Ring Amplitude is 120mV 
 

3. Frequency modulated sine wave of 3.54 MHz carrier frequency, 900 mV carrier 
amplitude, modulation amplitude of 370 KHz with 3 LSB RMS noise. 
 

4. Ultrasound signal consisting of a stimulus followed by two echoes. 
Stimulus: three pulses of a clipped 100 V signal 
First echo: Amplitude 300mV fixed @ 11µS 
Second echo: Amplitude 160 mV @19 +/- 3 µS 
Noise 7 LSB RMS 
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Switching from Basic to Advanced Demo Mode 

You may at any time switch to the Advanced Demo Mode by clicking on the Help menu !!!! 
Launch Advanced demo option. 
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Uninstalling GageScope® (page A-19) 

Note that this section in the �Getting Started� chapter has been modified to reflect a new 
procedure in uninstalling GageScope®. 

 

GageScope® is equipped with a special uninstall program, allowing you to uninstall all 
components at once.  To uninstall, simply follow these steps: 

Note: Depending on the OS installed on your system, the process of removing GageScope® 
may be different and will not necessarily appear the same as the following. 

1 In your Windows Start menu, select Settings →→→→ Control Panel. 

2 Double-click on Add/Remove Programs. 
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3 The Add/Remove Program Properties dialog box will appear:  

 
 
In the list of programs, select GageScope®.  Click Add/Remove. 

Note: This screen may differ depending on which OS you are running. 

4 The Select Components dialog will appear. 

 

Click Yes.  
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5 The Uninstall process will begin.  You will see the uninstall progress indicators during 
this uninstall process. 
 

 
 
 

6 All components will be uninstalled as soon as you confirm by clicking OK. 
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Decimation Mode (pages B-140 to B-154) 

This section on Decimation is intended to replace the one found in Tutorial 4 of the 
GageScope® User’s Guide. 

 

Scientists and engineers working with Gage A/D and Scope cards equipped with very large 
acquisition memories encounter a singular problem: how to display a large amount of data 
using the much smaller memory typically found in personal computers.  In order to solve this 
problem, GageScope® uses a special mode of operation called Decimation Mode. 

In essence, Decimation Mode offers the user various ways of summarizing the acquired data.  
This summary of the captured data can then be displayed in GageScope® as a form of preview 
called �decimated data.�  For this reason, and to simplify the task of working with large 
quantities of data, Decimation Mode is comprised of a few key functionalities: 

• Decimation (and display of decimated data) 
• Deep Memory Zoom (DMZ) 
• Saving of un-decimated data as large signal files 
• Split File Saving and Replay 
• Loading of large signal files 
 

Because of the characteristics described above, Decimation Mode must be understood as a 
tool that works in conjunction with large acquisitions only.  GageScope® has been designed to 
prevent normal users (those equipped with boards of up to 16MS of acquisition memory) 
from ever having to use decimation.  This is achieved chiefly by limiting the range of 
Deep Memory (DM) Buffer that can be used with each board. 

For deep acquisition memory boards, users control the decimation through the value given to 
the DM Buffer and the type of decimation performed (MinMax or Mean).  GageScope® 
therefore offers a relatively simple decimated view of the data, but more than makes up for 
this previewing technique by offering a powerful way to zoom-in and display specific 
portions of the data acquired. 

After capture, decimation, previewing the data and zooming-in on some of the data, users can 
elect to save the entire acquisition in one large file or to literally chop the large acquisition 
into any number of smaller files that are then easier to analyze and/or share with other. 

The rest of this section will describe in details how each of the Decimation Mode operations 
function, and provide more information on the particulars of working with large acquisitions. 
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How Decimation Works 

1 Prior to setting up a capture requiring decimation, it is recommended that you go to Stop 
Mode.  This ensures that no lengthy acquisition is launched before all the parameters are 
set to the desired values. 

In the System Control, combine PreTrig and PostTrig depths so as to set the total 
acquisition depth to any value greater than 16 MS, up to the full depth of the board.  
GageScope® will give you a warning to let you know that you are entering Decimation 
Mode: 

The Decimation Mode is enabled as soon as the size of acquisition per channel is more 
than ¼th of the size of the DM Buffer.  For instance, let us assume that you have 
allocated 8 MB for the DM Buffer.  In this case, the Decimation Mode will be 
automatically activated whenever you specify more than 2 MB of total acquisition length 
in GageScope®.  The total acquisition length is the sum of the pre- and post-trigger data 
sizes. 

Click on the YES button. 

You can now acquire a signal.  Click on the CAPTURE icon to begin capturing data. 
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2 You will see the �Decimation in Progress� dialog box pop up indicating that GageScope®

has captured the data and is now in the process of decimating it before displaying in the 
display window.  The status and time remaining to complete the required decimation task 
will be shown.   

You may choose to continue or abort the decimation at any time during this operation by 
simply clicking on the buttons located in the �Decimation in Progress� dialog box. 
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3 The decimated channels, in the �YT1: Deep� display, will appear: 
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 You can now open the Preferences dialog box by clicking on Tools !!!! Preferences.  
The Preferences dialog box will appear as follows: 



Addendum to GageScope® User�s Guide 48

 

4 Set the DM Buffer to 64 MB, then select the decimation method (MinMax or Skip 
Sample) and click Apply. 

The result of the capture and MinMax decimation of a sine wave captured by a 
CompuScope 14100 card on two simultaneous channels will look like this: 

While computers may have a varying amount of RAM, in GageScope® the DM Buffer 
size must be between 1 and 64 megabytes so as to ensure smooth operation on the vast 
majority of PCs.  Because the DM Buffer implicitly controls the decimation factor used 
by GageScope®, care must be exercised in specifying a value for the DM Buffer size. 

Decimation can be best understood as a way of creating a summary of the real data.  The 
smaller the amount of memory is given to creating the summary (the DM Buffer), the 
shorter and less representative the summary.  Conversely, the maximum DM Buffer size, 
64 MB, will also give the least decimation and a more accurate depiction of the captured 
data. 

Note: The physical RAM present in the PC limits the DM buffer size by a factor of ¼. 
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5 A Skip Sample decimation of the same signal would look like this: 

The decimated view is useful to identify the location of peaks in the signal (particularly 
when using the MinMax method) or large-scale patterns in the data.  From this summary 
view, GageScope® provides a powerful way of �zooming-in� on the areas of the captured 
data that may be of particular interest. 

On the other hand, the decimated view cannot be used to calculate Waveform Parameters 
or to perform mathematical operations on the signal.  

The Skip Sample method reads the captured data and extracts 1 value for each group of 
x digitized samples.  The MinMax method calculates the minimum and maximum values 
of an entire group of x/2 samples and then displays both values at the same time value. 
Hence the MinMax method stores 2 values for each group of x/2 digitized samples. 

The x quantity of the previous paragraph is given by the equation: 

x = (Total Samples * 8) / DM Buffer 

Note: The factor that is used will be rounded to the next integer value, i.e. if x=2.5, the 
result will be rounded to 3. 
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How the Deep Memory Zoom Works 

6 Continuing our work with a large acquisition, now that we have a decimated view we 
wish to zoom-in on an area of interest.  We call-up the Deep Memory Zoom (DMZ) by 

clicking on the DMZ button:   

This action brings up a special cursor in the decimated view: 

The DMZ cursor behaves mostly like a normal cursor: you can move it to the desired 
position by moving the mouse.  You can scroll through the decimated data while the 
cursor is active by using the window�s scroll arrows as usual. 
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7 Once the DMZ cursor is in the desired location, left-click to bring up the DMZ dialog: 
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8 The DMZ dialog box options are as follows: 
 

Channels Shows the channels being decimated and the name of 
the CompuScope card.  These are the channels from 
which captured (not decimated) data can be fetched 
from the CompuScope memory by the DMZ. 
 

First and Last 
Sample 

The starting and ending samples of the data to be 
displayed in the Zoom window.  
 
First sample is the starting point from which captured 
data will be fetched from the CompuScope memory. 
 
Last sample is the end point of the range of captured 
data that will be fetched from the CompuScope 
memory. 
 

Virtual 
Trigger 
Position 

The Virtual Trigger Position is a feature GageScope® 
uses to co-ordinate a small segment of captured data 
with other signals or math channels.  It consists of 
assigning a specific sample the role of Trigger Sample, 
but solely for the purpose of displaying and performing 
operations on the signal. 
 

# of Samples 
Selected 

The total number of samples to be displayed.  The 
minimum default value is 256 samples (cursor width) 
and the maximum is 16,777,216 samples.  
  



 

Addendum to GageScope® User�s Guide 53

9 Select the channel(s) from which to fetch captured (not decimated) data, then adjust the 
First Sample and Last Sample values to fine-tune the range of data to display.  Finally, 
select a value for the Virtual Trigger sample number (see below for more details). Click 
OK. 

The selected range of data is fetched from the CompuScope and displayed in a normal 
display window: 

Note the presence of the cursor in the decimated view, with the name �YT2� displayed in 
the gray �range� bar at the bottom.  This allows you to quickly identify which position 
and range of the decimated signal has been zoomed into. 
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10 Maximizing the CS14100:YT2 display and expanding the Timebase, we can see that it is 
as if the data was obtained from a �normal� short acquisition.  Note also that all the usual 
operations can be performed on the displayed signals. 

The DMZ is used to query the CompuScope board for a segment of captured data 
without requiring decimation.  For this reason, the segment to be fetched and displayed is 
limited in size to 16 MS and appears disconnected from the complete signal and 
particularly from the real trigger location.  Thus the importance of assigning a position to 
the Virtual Trigger. 
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11 You can put more DMZ cursors in the decimated view, or you can modify the existing 
cursor to select a different range or different options.  To modify an existing cursor, 
double-click on it.  A slightly different DMZ dialog window appears: 

This dialog works exactly the same way except that it only modifies the existing signals 
already displayed in the case of our example, the CS14100:YT2. 

The DMZ has an important limitation to keep in mind when working in Decimation 
Mode: GageScope® can only support 4 zoom cursors at the same time. 
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Saving Large Acquisitions: Un-decimated and Split File Saving 

 
12 Once a large acquisition has been made and looked at in detail with the Deep 

Memory Zoom, we typically want to save the data for later use, either with 
another software application for analysis purposes, or with GageScope® for 
more processing. 

GageScope® provides a number of methods for saving data: Saving a Channel 
(for saving a portion of the data viewed with the DMZ), Save Un-decimated 
(for saving the entire acquisition as a single .SIG file) and Save Split File (about 
which this section will be mostly concerned). 

Saving a channel displayed from a DMZ is exactly the same as saving a channel 
acquired with a normal acquisition.  The only difference consists in the 
reference to the Trigger location: from the DMZ channel, the Virtual Trigger 
value is saved as an absolute trigger and all references to the real trigger of the 
large acquisition are lost.  To learn how to save a channel, see File: Save 
Channel also in this manual. 

Partially because of this loss of trigger information, it is often better to simply 
save all of the data as a single signal file.  To save the data as un-decimated, go 
to File !!!! Save Channel.  The following dialog appears: 
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As already indicated on the dialog, click the �Save undecimated data� checkbox, choose 
which channel to save (Ch. 01 in this case), enter a name for the file (�test� in the case of 
the example), select a location for the file, and then click on Save. 

This operation results in a single, large file being save for later use. 

Some analysis software tools find it difficult to use such a large file and perform 
operations on it.  GageScope® offers a very practical alternative to saving a single large 
file. 
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13 Instead of selecting the �Save undecimated data� option in the Save Channel dialog, we 

could have pressed the Split File Save button:   

Alternatively, we could get directly to the Split File Save dialog by selecting File !!!! 
Split File Save.  Either way, we get to the following dialog: 

This dialog allows you to separate the acquired signal into any number of files, and even 
to group the files in series to be saved in separate folders. 
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14 The example displayed above will save the content of Channel 01 as 64 files of 
1,000,000 samples each.  The files will be named using the Directory Prefix, File Prefix 
and a Sequential File Number.  Clicking OK will save these 64 files. 

In Windows Explorer, the saved files would look like this: 

The Windows operating system has an intrinsic limitation of 64,000 files per folder.  
When saving a large acquisition as a large number of very small files, care must be taken 
to not exceed this limit.  This is why GageScope® allows for the selection of both the 
number of samples to save per file as well as the number of files to put in each folder.  In 
the example above, selecting 1,000 samples per file and 64 files per folder would result 
in 1,000 folders being created, each with 64 files. 
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15 Saving large acquisitions as Split Files would be of limited use if GageScope® did not 
allow for opening and displaying the files again.  You can access the Split Files through 
Tools !!!! SplitFile play back� 
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 � and then selecting the appropriate files, starting with the first folder of the Split File 
structure: 
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16 GageScope® confirms the Split File structure and asks for confirmation: 
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 As can readily be observed, the replay of Split Files is exactly like the playback of 
AutoSave files: 
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Loading Large Files 

17 Since GageScope® allows the saving of a single data file from a large acquisition, it must 
be possible to load such a file to verify its content and perform analysis. 

Due to memory management issues under the Windows family of operating systems, 
GageScope® limits the amount of data that can be loaded from a single file.  To 
compensate for this limitation, however, GageScope® offers added flexibility in selecting 
the portion of a file that is to be loaded. Here is how this is done. 

Go to File !!!! Load Channel and select a large file (in this example, we use the 
previously saved �test� file): 
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18 Select the large file and click Open.  A new dialog appears: 

From this Partial file load dialog, GageScope® allows for the selection of the Start 
Sample and End Sample of the portion to load.  GageScope® automatically calculates 
the size selected and indicates if the file can be loaded as specified by enabling the OK 
button. 

The Partial file load dialog seen earlier also includes options for loading MulRec files.  
The right-hand side of the dialog allows the selection of the First record as well as the 
Number of records to be loaded. 
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19 In our continuing example, we are attempting to load 4,000 samples, starting with sample 
6,000 and ending with sample 10,000.  The result is what appears like any other signal 
file loaded in GageScope®; channel 05 in the �CS14100:YT2� display below: 
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File: Save Setup (page C-7) 

Please note that the Save and Load functionalities have been changed, and so the following 
two sections are intended to replace those found in the Reference chapter within the 
GageScope® User’s Guide. 

 

Since so many settings can be changed, and because users may wish to perform various 
complex tasks at different times, GageScope® provides a convenient way of preserving 
favorite settings.  The Save Setup command saves current GageScope® settings in a Setup file 
with the extension .INI.  This Setup file can later be restored manually (see File: Load 
Setup). 

What is Saved in the Setup file 

In summary, the Setup files record the following information: 

• CompuScope card Display Settings: Channel mode, sample rate, etc. 
• Channel Settings: input range, coupling, position, vertical scale, polarization, channel 

name, comments, etc. 
• Trigger Settings: Trigger type, trigger level, timeout, trigger slope, depth units, post-

trigger depth, pre-trigger depth, etc. 
• Display Settings: Timebase, channel visibility, etc. 
 
For a detailed list of parameters saved, see Appendix F. 

How it Works 

1 Choose Save Setup from the File menu. The Save Setup dialog appears. 
 

2 In the �File name� field, type in a file name. 
 

3 Browse to, or specify, the folder where you would like to save your Setup file. 
 

4 Click Save to save the Setup file 
. 
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GageScope® for DOS Setup File Compatibility 

The GageScope® setup file format (.INI) is not compatible with the GageScope® for DOS 
setup file format (.SET). 
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File: Load Setup (page C-8) 

When launching GageScope®, the last setup parameters that were being used are 
automatically restored. 

The Load Setup command allows the user to manually load a previously saved Setup file.  A 
Setup file contains the GageScope® settings which were current at time of saving (see File: 
Save Setup).  The Setup file has the extension .INI. 

 

How to Load a Setup Manually 

1 If not already in Stop Mode, click Stop  in the Toolbar to stop the current acquisition.
 

2 Choose Load Setup from the File menu.  The Load Setup dialog appears. 
 

3 Go to the folder where you saved your Setup files and choose a file from the list. 
 

Exceptions 

Upon starting-up for the first time, GageScope® chooses several default settings.  These 
default settings are saved in the Key Registry of the Windows operating system and cannot be 
modified by the user.  They remain available as a way to restore GageScope® from a situation 
that may cause problems. 

Should the hardware configuration of the system be changed between sessions, GageScope® 
will fail to restore the previously used settings.  In such cases, the user is prompted to provide 
an alternative Setup file from which to load settings, or to revert to the default GageScope® 
settings. 

 

Error Trapping When Loading Setups 

1 If a setup parameter being read does not match the current hardware configuration, the 
user is given a warning and details as to which condition and parameter do not match. 
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2 The user is then given the following options: 

1. Continue loading all other parameters, ignoring the current error, 

2. Ignore all errors while loading, which causes only the settings that can be loaded to 
be extracted from the Setup file, and the rest to be set to default values, 

3. Stop loading from the Setup file and return to the GageScope® defaults, 

4. Choose another Setup file to be loaded instead. 
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Multiple Record Mode (Pages B-114 and C-88)  

The introduction of Pre-Trigger Multiple Record capabilities on some CompuScope cards has 
caused the description of User’s Guide�s description of Multiple Record Mode to become 
incomplete.  This section replaces pages C-88, the description of the feature, as well as page 
B-114, the first page of the tutorial on Multiple Record found in Tutorial 4. 

 

Multiple Record Mode takes advantage of the CompuScope card�s deep memory buffers by 
allowing the hardware to stack captures in on-board memory, so that many small acquisitions 
can occur in a very short amount of time, with near-zero re-arm time.  This feature is 
invaluable in applications in which trigger events are happening rapidly or unpredictably and 
A/D down-time must be minimized. 

When Multiple Record Mode is enabled, the CompuScope card looks for a trigger event, 
acquires data, then automatically re-arms itself to look for another trigger event.  Data 
collected from each successive acquisition is "stacked" on top of the previous acquisition until 
the on-board buffer fills up.  

For example, if an acquisition depth of 1024 points is specified, the first acquisition stores 
data in addresses between 0 and 1023, the next acquisition from 1024 to 2047, and so on until 
the buffer is full.  

Important Notes 

• With most currently available CompuScope cards, you can only capture post-trigger 
data in Multiple Record mode.  When you click on the MulRec button, pre-trigger 
capture is disabled.  For those CompuScope cards with Pre-Trigger Multiple Record 
acquisition, the pre-trigger is not disabled when clicking on the MulRec button.  For 
the sake of brevity we will only describe post-trigger data acquisition.  The case with 
pre-trigger data is completely analogous. 

• The number of records you can capture will depend on the amount of on-board 
memory your CompuScope card has, as well as other settings, such as the post-
trigger depth and channel mode. 

• Multiple Record Mode comes as a standard feature or as an option on most 
CompuScope cards, but is not available on the CompuScope LITE.  If your 
CompuScope card does not have this capability, the MulRec button will not be 
available. 
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The Multiple Record setting is located in the Depth tab of the System Control. 
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Channel Control: CS Input Tab: Polarization 
(Page C-148) 

The Polarization settings and controls have been modified.  This page replaces page C-148 of 
the Reference section of the User’s Guide. 

 

The Polarization setting is labeled �Invert� and is located in the CS Input tab of the Channel 
Control. 

 

This setting is available whether All Channels or an individual channel is current. 

Polarization refers to how the trace is displayed relative to the X axis.  When polarization is 
normal, the channel is displayed exactly as captured.  Inverting the polarization inverts the 
signal about the X axis, modifying the digital values of the captured data. 

If a channel is inverted, the color of the channel identifier at the far left of the signal will be 
reversed as well.  For example, if channel 1 is inverted and its color is yellow, then the 
channel identifier will be black text in a yellow box. 

Toggling the Polarization via the CS Input Tab 

1 Click on the CS Input tab in the Channel Control. 

2 Click on the Invert button to toggle this option on and off.  If the Invert button is 
enabled, polarization is inverted; otherwise it is normal. 
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Changing the Polarization via the Channel Context 
Menu 

1 Position the mouse pointer on a channel�s zero line.  The channel will turn white to 
indicate that it has the current focus, and the mouse pointer will change to a drag pointer. 

2 Click on the right mouse button to bring up the channel context menu. 

3 Click on Invert to toggle this setting.  If Invert has a checkmark next to it, polarization 
is inverted; otherwise it is normal. 
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InfoView (page C-176) 

The InfoView window in GageScope® 3.5 has been changed.  What follows is intended to 
replace page C-176 of the GageScope® User’s Guide. 

 

The InfoView Window truly differentiates GageScope® from all other oscilloscope programs 
on the market.  Using the advanced analysis tools, GageScope® can analyze the signal data 
and display the results in the InfoView window.  InfoView is what the marriage of 
instruments and computers is all about. 

Any results calculated in GageScope® are displayed in InfoView.  Below is a sample of what 
the Waveform Parameters tool displays.  For more information on advanced analysis tools, 
see page C-177 of the GageScope® User’s Guide. 
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Waveform Parameters (pages C-205 to C-210) 

The Waveform Parameters dialogue has been changed in GageScope® 3.5.  The following 
pages are intended to replace pages C-205 to C-214 of the GageScope® User’s Guide. 

 

The Waveform Parameters tool automatically calculates various voltage and time parameters 
of a signal, such as mean, amplitude, and rise time.  In all, 21 parameters are available: 

• Top Value 
• Bottom Value 
• Mean 
• RMS 
• Amplitude 
• Peak to Peak 
• Period 

• Frequency 
• Time Stamp 
• Time Interval 
• Fall Time 
• Rise Time 
• Positive Width 
• Negative Width 

• Positive Duty 
• Negative Duty 
• Positive Overshoot 
• Negative Overshoot 
• Peak 
• Trough 
• Num Cycles 

 

Parameters are displayed in the InfoView window at the far left of the GageScope® screen. 
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For definitions of what each parameter measures, see About the Parameters below. 

 

GageScope® now also features the ability to save Waveform Parameters to a binary file.  A 
Waveform Parameter file viewer is included in the GageScope® package.  Using the 
Waveform Parameter viewer, Waveform Parameter measurements can be re-saved in ASCII 
format.  (The direct save from GageScope® to ASCII of the waveform parameters is not 
supported.) 

 



 

Addendum to GageScope® User�s Guide 79

Adding Parameters to the InfoView 

1 To display a parameter, right-click on the InfoView window and choose Edit Waveform 
Parameters.  You can also choose Waveform Parameters from the Tools menu or the 

 button in the Toolbar. 

The Parameters dialog box appears.  
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2 Click on the channel number you want to measure.  

 

 

 



 

Addendum to GageScope® User�s Guide 81

3 Click on the checkbox of each parameter you want to display in the InfoView window.  
You may have to scroll down the list to find the parameter you want. 

A checkmark indicates the parameter will be shown; the lack of a checkmark indicates 
the parameter will not appear. 

 

To enable all parameters, click on the Select All button.  To disable all parameters, click 
on the Deselect All button. 

 

4 Click OK when finished or Cancel to abort the changes. 

Once you click OK, the parameters appear in the InfoView window. 
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Expanding and Collapsing Parameters 

Many of the parameters can display the average value and standard deviation.  Such 
parameters have a plus sign to the left of their name in the list.  To expand a parameter and 
see the average values and standard deviations, click on the plus sign to the left of a 
parameter.  To collapse the parameter back to its original state, click on the minus sign. 
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Method and Reference Settings 

When calculating certain parameters, the Waveform Parameters tool relies on the Reference 
and Method settings located in the Parameters dialog. 

 

For information on how particular parameters are affected by these settings, see About the 
Parameters below.  Not all parameters make use of these settings. 

 

The Method Setting 

The options for Method are MinMax and Histogram.  To change the Method setting, select 
a value from the drop-down menu.  The default is MinMax. 

The Histogram Method is preferred for pulse-based signals such as digital logic (CMOS, 
TTL, ECL, etc.). 

The MinMax Method is preferred for other signals, such as sine waves. 
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The Reference Settings 

The reference settings High, Middle and Low are used to determine the High Level, Middle 
Level, and Low Level when calculating certain time parameters.  For example, the Rise Time 
is the length of time for a signal�s rising edge to go from the low level to the high level. 

To change the Reference settings, click on the Increment buttons next to High, Middle and 
Low. 

The definitions for High Level, Middle Level, and Low Level are shown below.  
Reference:High%, Reference:Middle%, Reference:Low% refer to the values in the Reference 
settings in the Parameters dialog box. 

High Level = LowFlatValue + (HighFlatValue - LowFlatValue) x Reference:High% 
Middle Level = LowFlatValue + (HighFlatValue - LowFlatValue) x Reference:Middle% 
Low Level = LowFlatValue + (HighFlatValue - LowFlatValue) x Reference:Low% 
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About the Parameters 

Use the diagrams below to get an idea of what each parameter measures.  More detailed 
explanations are offered on the pages following the diagram. 

 

Voltage Parameters 

 

 

Time Parameters 
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Calculating the Parameters 

All parameters are calculated based on the information displayed on the screen, as opposed to 
the entire data acquisition buffer (which is stored on the computer but not necessarily 
displayed all at once).  Hence you may notice that certain measurements change as the time 
base of the display is modified; this is simply because more or less of the signal is displayed 
and some features of the signal can cause the waveform parameter values to change. 

This feature of GageScope® can sometimes lead to confusion but in fact it is a very powerful 
way of performing comparisons between various portions of a long acquisition, especially for 
non-repetitive signals. 

As discussed previously, some waveform parameters can be expanded (by clicking on the + 
sign) to display the average and standard deviation values.  Such parameters are measured on 
a per-cycle basis; one value is calculated for each cycle.  The average and standard deviation 
values are therefore the average and standard deviation of the per-cycle values, over the 
cycles displayed on the screen. 

 

Definitions 

The parameters are defined as follows: 

Top Top is the average of the highest values recorded for all the cycles in 
the displayed signal. 

Bottom Bottom is the average of the lowest values recorded for all the cycles 
in the displayed signal. 

Mean Mean is the average of all the points in the displayed signal. 

RMS RMS is the Root Mean Square voltage. 

Amplitude When the MinMax method is chosen, Amplitude is equal to the Peak 
to Peak value.  When the Histogram method is chosen, the Amplitude 
is the difference between the High Flat and Low Flat values, in Volts. 

Peak To Peak Peak-to-Peak is the absolute difference between the Maximum and 
Minimum values, in Volts. 

Period Period is the time it takes for a signal to complete one cycle and is 
equal to the sum of the Positive and Negative Widths. 

Frequency Frequency is the number of cycles per second in a signal, measured in 
Hz, with 1 Hz equaling 1 cycle per second, and is equal to 1 / Period. 
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Time Stamp Time Stamp displays the time stamp of the record.  This parameter is 
only active with the use of a Trigger Marker Board. 

Time Interval Time Interval displays the time difference between two successive 
records.  This parameter is only active with the use of a Trigger Marker 
Board. 

Fall Time Fall Time is the length of time for a signal�s falling edge to go from the 
High Level to Low Level. (These two levels are specified in the 
Reference:High and Reference:Low settings in the Parameters dialog 
box.) 

Rise Time Rise is the length of time for a signal�s rising edge to go from Low 
Level to High Level. (These two levels are specified in the 
Reference:High and Reference:Low settings in the Parameters dialog 
box.) 

PosWidth Positive Width is the length of time between the rising and falling edge 
of the portion of the signal above the Middle Level. (This level is 
specified in the Reference:Middle setting in the Parameters dialog 
box.) 

NegWidth Negative Width is the length of time between the falling and rising 
edge of the portion of the signal below the Middle Level. (This level is 
specified in the Reference:Middle setting in the Parameters dialog 
box.) 

PosDuty Positive Duty is a percentage of the time it takes for the positive 
portion of a signal to complete, compared to one whole cycle.  It is 
defined as: 

(Positive Width ÷ Period) x 100 

NegDuty Negative Duty is a percentage of the time it takes for the negative 
portion of a signal to complete, compared to one whole cycle.  It is 
defined as: 

(Negative Width ÷ Period) x 100 

PosOvershoot Positive Overshoot is measured in Volts and is defined as: 

Maximum Value - High Flat Value 

When the method is set to MinMax, Positive Overshoot is 0. 
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NegOvershoot Negative Overshoot is measured in Volts and is defined as: 

Minimum Value - Low Flat Value 

When the method is set to MinMax, Negative Overshoot is 0. 

Peak Peak is the highest voltage value recorded for each cycle. 

Trough Trough is the lowest voltage value recorded for each cycle. 

NumCycles Number of cycles is the total number of complete cycles in the 
displayed signal. 
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Appendix F: Setup Parameters Saved and 
Loaded 

System Settings 

Setting Default Value 
(if applicable) 

Values Available 
(if not all possible) 

Path for user-defined INI files   
Directory for loading SIG files   
Directory for saving SIG files   
Directory for saving and 
restoring EGG files 

  

Use Smart Tabs YES  
Show ToolTips YES  
Ask user to abort long captures YES Yes or Take Default 

Action 
Default action on stopping long 
captures 

Abort Abort or Wait 

Deep memory buffer size per 
channel 

64 MB 32 or 64 MB 

 

Card Settings 

Setting Default Value 
(if applicable) 

Values Available  
(if not all possible) 

Capture Mode Continuous Mode Continuous or 
Stopped 

Channel Mode Dual (if 2 ch. avail.)  
Sample Rate Highest Available  
SuperRes Mode OFF  
Scope Mode NO  
Window Count 1  
External Clock NO  
Clock Rate 10 MHz  
MulRec Mode NO  
MulRec Record Count   
Pre-Trigger Depth 4 kS Max. 1 MS 
Post-Trigger Depth 4 kS Max. 1 MS 



Addendum to GageScope® User�s Guide 90

Trigger Settings 

Setting Default Value 
(if applicable) 

Values Available 
(if not all possible) 

Trigger Source Channel 1  
Trigger Level 0  
Trigger slope Positive  
Timeout 10 ms  
Number of Trigger Sources 1  
Sources of Triggers Channel 1  
Levels of Triggers 0  
Slopes of Triggers Positive  
Timeouts of Triggers 10 ms  
 

Display Settings 

Setting Default Value 
(if applicable) 

Values Available 
(if not all possible) 

Timebase 20 * tbs / div  
Trigger Alignment Mid-Window  
Persistence OFF  
Cursors OFF  
Engineer Units Volts  
Grid ON  
Grid Color ON  
X/Y Axis   
X/Y Axis Color   
Zero Lines ON  
Zero Lines Color   
Color of Window   
Window Position (0,0)  
Window Size Full  
Printing Colors   
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Channel Settings 

Setting Default Value 
(if applicable) 

Values Available  
(if not all possible) 

Channels Shown All Visible  
Channel Name   
Channel Position Evenly distributed  
Default Trace Alignment   
Trace Connect Dots YES  
Trace Line Thickness Thinnest  
Trace Line Linetype Continuous  
Input Range +/- 1 V  
Vertical Scale biggest value smaller than 

[(4/NumOfChan) * input 
range /div] 

 

Polarization Normal (not inverted)  
Probe x1  
Coupling DC  
Decimation Method Skip Sample  
Decimation Factor Min (Card, Display) See 

DMB specs in section 5.2. 
 

 

Analysis Setting 

Setting Default Value 
(if applicable) 

Values Available  
(if not all possible) 

Waveform Parameters NONE  
FFT Parameters 1024, exact Blackman-

Harris 
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